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FOXIT CORPORATION LICENSE AGREEMENT 

FOR FOXIT PDF IFILTER 

 

IMPORTANT-READ CAREFULLY:  This Foxit Corporation (“Foxit”) License Agreement 

("License" or “Agreement”) is a legal agreement between You (either an 

individual or an entity, who will be referred to in this License as "You" or “Your”) and 

Foxit for the use of Foxit PDF IFilter, and which may include associated media, 

printed materials, and other components and software modules including but not 

limited to drivers ("Product").  The Product also includes any software updates and 

upgrades that Foxit may provide to You or make available to You, or that You 

obtain after the date You obtain Your initial copy of the Product, to the extent 

that such items are not accompanied by a separate license agreement or terms 

of use.  BY INSTALLING, COPYING, DOWNLOADING, ACCESSING OR OTHERWISE 

USING THE PRODUCT, YOU AGREE TO BE BOUND BY THE TERMS OF THIS FOXIT 

LICENSE AGREEMENT.  IF YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT 

YOU HAVE NO RIGHTS TO THE PRODUCT AND SHOULD NOT INSTALL, COPY, 

DOWNLOAD, ACCESS OR USE THE PRODUCT. 

The Product is protected by copyright laws as well as other intellectual property 

laws.   The Product is licensed and not sold. 

1.      GRANT OF LICENSE. Foxit grants You a non-exclusive, nontransferable license 

to install and use the Product subject to all the terms and conditions set forth here 

within.  

1.1.     Single-Use Perpetual License. You may permit a single authorized end user 

to install the Product on a single computer for use by that end user only.  Remote 

access is not permitted without the express written consent of Foxit. 

1.2.     Single-Use Term License. Same usage terms as the Single-Use Perpetual 

License.  The period of use is limited to a fixed duration at which the time the 

Product must be deinstalled from the computer unless the license is renewed for 

an additional period of time. 

2.      ADDITIONAL LIMITATIONS.  You may not reverse engineer, decompile, or 

disassemble the Product, except and only to the extent that it is expressly 

permitted by applicable law notwithstanding this limitation.  You may not rent, 

lease, lend or transfer the Product, or host the Product for third parties.  The 
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Product is licensed as a single integral product; its component parts may not be 

separated for use on more than one computer.  The Product may include copy 

protection technology to prevent the unauthorized copying of the Product or 

may require original media for use of the Product on the computer.  It is illegal to 

make unauthorized copies of the Product or to circumvent any copy protection 

technology included in the Product.  The software may not be resold either by 

You or a third party customer without the prior written permission of Foxit.  All rights 

not expressly granted to You are retained by Foxit. 

2.1.     Third Party Software. The Product may contain third party software that Foxit 

can grant sublicense to use and which is also protected by copyright law and 

other applicable laws.  

3.      EDUCATIONAL USE. If the Product You have received with this Agreement is 

an Educational Software Bundle (where the Product is received by virtue of Your 

participation in a Foxit program designed for educational or research institutions, 

or is provided by Foxit to You under some other arrangement), You are not 

entitled to use the Product unless You are an employee or student of such 

educational institution.  Educational Software Products may be used for 

educational and research purposes only. Commercial and general production 

use of Educational Software Products are specifically prohibited.  The Product is 

provided under a Single-Use Term License as described above.  You may install 

one copy of the Product on one desktop computer in a designated computer 

used for educational purposes under Your license agreement.  Your Educational 

license is granted for a period of one year, unless stated otherwise, from when the 

Product license keys are made available to You.  Your Educational license entitles 

You to email and telephone support for up to two designated employees and 

product upgrades during the term of Your license.  You grant Foxit the right to use 

material created under such license for marketing and advertising purposes. 

4.      SUPPORT AND MAINTENANCE TERMS AND CONDITIONS.  

4.1.     Term of Maintenance. Foxit agrees to provide Maintenance (as defined 

herein) to You pursuant to the terms and conditions set forth herein provided that 

You pay the Maintenance Fee for each Product for which Maintenance is desired 

and as further described in Section 4.4 below. Maintenance will be provided for a 

period of one year, unless otherwise agreed to by the parties in writing, from the 

date of purchase of the Product (the “Initial Support and Maintenance Term”), 

and with renewals, annually from the expiration date of the prior Support and 

Maintenance Term.  Failure to renew annual maintenance may result in You 

having to purchase a new license in order to receive future versions of software 
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and associated ongoing support and maintenance. 

4.2.     Maintenance Services. In exchange for the Maintenance Fee, Foxit agrees 

to provide to You during the term of this Agreement support and maintenance 

(collectively "Maintenance") as follows:  

4.2.1.    Support: Foxit will provide email and telephone support to You for current 

versions of the Product. Foxit will investigate all of Your questions and problems 

promptly.  You agree to provide adequate information to Foxit to assist in the 

investigation and to confirm that any problems have been resolved. Foxit does 

not provide guaranteed response time but will make good faith effort to answer 

emails and voice mails within twenty-four (24) hours or less during weekdays, 

excluding holidays. 

4.2.2.    Maintenance: Foxit will supply to You, at no additional charge, any 

improvements, upgrades, or modifications to the Product that Foxit makes 

generally available. Any such improvements, upgrades, or modifications shall 

become part of the Product for all purposes of this Agreement.  

4.2.3.    You acknowledge and agree that the Maintenance to be provided by 

Foxit hereunder is limited to the most current version of the Product and the 

immediately preceding version.  

4.3.     Exclusions. Foxit’s obligation to provide Support is contingent upon proper 

use of the Product and full compliance with this Agreement. Moreover, Foxit shall 

be under no obligation to provide Support should such services be required due 

to (a) failure to operate the Product within the systems requirements provided for 

the Product (b) any modification or attempted modification of the Product by 

You or any third party or (C) Your failure or refusal to implement Product changes 

recommended by.  

4.4.     Consideration. In payment of the Maintenance services to be provided by 

Foxit hereunder, You shall pay Foxit, or its authorized agent, the applicable fee for 

the Initial Support and Maintenance Term as indicated on the related invoice, 

receipt, purchase order, or other ordering document ("Maintenance Fee").  At 

the end of the Initial Support and Maintenance Term, or any subsequent Support 

and Maintenance Term, You may renew participation in Maintenance services for 

additional annual term(s) provided You (a) are current on all payments due to 

Foxit and (b) pay Foxit, or its authorized agent, the applicable renewal fee, which 

Foxit, or its authorized agent, shall invoice prior to the end of the preceding term, 

unless terminated by You at least 30 days prior to the expiration of the then current 

Support and Maintenance Term.  The Maintenance Fee for renewal shall be 

equal to the Maintenance Fee for the immediate preceding annual term plus an 
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increase by a percentage not to exceed the Consumer Price Index (CPI), as 

published by the U.S. Department of Labor.  In addition, Maintenance shall be 

discontinued for any and all subsequent Support and Maintenance Terms for 

which You fail to pay Foxit the invoice within ten (10) days after the prior 

Maintenance expiration date.   

4.5.     Exceptions.  For use of the Product or a Beta Software Product, only the 

Maintenance Services and Exclusions paragraphs of this section apply.  For use of 

the Product under Educational Use terms, the Maintenance Services and 

Exclusion paragraphs apply as long as You pay for the maintenance period 

defined under Your Single-Use Term License. 

5.      PAYMENT TERMS. Unless explicitly set forth in this Agreement, all fees and 

other amounts due under this Agreement are non-cancelable and 

non-refundable.  Unless otherwise agreed to by the parties, You shall pay all fees 

or amounts within 30 days of the date of the invoice. A late fee shall be charged 

on any overdue amounts and any other fees and expenses not paid as provided 

under this Agreement at the rate of one and one-half percent (1½%) per month, 

or the highest rate allowable under applicable law, whichever is less, 

commencing with the date payment was due. 

6.      TAXES. The fees and all other amounts due as set forth in this Agreement are 

net amounts to be received by Foxit, exclusive of all taxes, duties, and 

assessments, including without limitation all sales, withholding, VAT, excise, ad 

valorem, and use taxes (collectively, the “Taxes”), and are not subject to offset or 

reduction because of any Taxes incurred by You or otherwise due as a result of this 

Agreement.  You shall be responsible for and shall pay directly, any and all Taxes 

relating to the performance of this Agreement, provided that this paragraph shall 

not apply to taxes based solely on Foxit’s income. 

7.      CONSENT TO USE OF DATA.  If Foxit provides any support services to You, You 

agree that Foxit and its affiliates may collect and use all information You provide 

as a part of any such support services related to the Product.  Foxit agrees not to 

use this information in a form that personally identifies You.    

8.      INTELLECTUAL PROPERTY RIGHTS.  Subject to the license grant hereunder, all 

right, title and interest in and to the Product, the accompanying printed materials, 

and any copies of the Product are owned by Foxit and its l icensors.  

9.      EXPORT RESTRICTIONS. You acknowledge that Product is of U.S. origin.  You 

agree to comply with all applicable foreign, federal, state and local laws and 

regulations governing Your use of the Product.  Without limiting the foregoing, in 

the event that this Agreement permits export of the Product outside the U.S., You 
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shall be solely responsible for compliance with all applicable U.S. export laws, rules, 

and regulations. The Product is subject to the U.S. Export Administration 

Regulations and other U.S. law, and may not be exported or re-exported to 

certain countries (currently Cuba, Iran, Libya, North Korea, Sudan and Syria) or to 

persons or entities prohibited from receiving U.S. exports (including those (a) on 

the Bureau of Industry and Security Denied Parties List or Entity List, (b) on the 

Office of Foreign Assets Control list of Specially Designated Nationals and Blocked 

Persons, and (c) involved with missile technology or nuclear, chemical or 

biological weapons). 

10.   WARRANTY 

10.1.  Warranty.  Foxit warrants that for a period of 90 days from the date of 

delivery (“Warranty Period”), under normal use, the Product will perform 

substantially in conformance with the specifications published in the 

Documentation.  During such period, and as the sole obligation of Foxit and Your 

sole remedy under the warranty in this Section, if You provide written notice of 

Foxit’s failure to comply with the above warranty, Foxit will use reasonable 

commercial efforts to correct such nonconformity in the Product as in 

accordance with the terms of the Maintenance and Support Policy.  In addition, 

if Foxit determines it is not commercially reasonable to correct the nonconformity, 

Foxit may elect to terminate the license to such Product, upon which termination 

Licensee will promptly return to Foxit all such copies of such Product. Upon receipt 

of the Product from Licensee, Foxit will return to Licensee all license fees (and any 

unused support fees) paid to Foxit by You for such Product. This warranty set forth 

above does not apply to, and Foxit shall have no obligation with respect to, any 

non-conformity arising as a result of (i) use of the Product other than as specified 

under this Agreement and the related Documentation; (ii) any modification or 

alteration of the Product performed other than by Foxit or its agents, or (iii) transfer 

of the Product to any computer system other than the ones on which Product is 

authorized to be stalled, except as permitted in this Agreement. 

10.2.  Disclaimer.  Other than the warranty set forth in Section 10.1 above, and to 

the maximum extent permitted by applicable law, Foxit, its authorized resellers 

and their subsidiaries  provides the Product and any support services related to 

the Product ("Support Services") AS IS AND WITH ALL FAULTS, and hereby disclaim 

all other warranties and conditions, either express, implied or statutory, including, 

but not limited to, any implied warranties, duties or conditions of merchantability, 

of fitness for a particular purpose, of accuracy or completeness of responses, of 

results, of workmanlike effort, of lack of viruses, and of lack of negligence, all with 
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regard to the Product, and the provision of or failure to provide support services.   

11.   LIMIT OF LIABILITY AND EXCLUSION OF INCIDENTAL, CONSEQUENTIAL AND 

CERTAIN OTHER DAMAGES.  TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE 

LAW, IN NO EVENT SHALL FOXIT, ITS AUTHORIZED RESELLERS OR THEIR SUBSIDIARIES 

BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT, PUNITIVE OR CONSEQUENTIAL 

DAMAGES WHATSOEVER (INCLUDING, BUT NOT LIMITED TO, DAMAGES FOR LOSS 

OF PROFITS OR CONFIDENTIAL OR OTHER INFORMATION, FOR BUSINESS 

INTERRUPTION, FOR PERSONAL INJURY, FOR LOSS OF PRIVACY, FOR FAILURE TO 

MEET ANY DUTY INCLUDING OF GOOD FAITH OR OF REASONABLE CARE, FOR 

NEGLIGENCE, AND FOR ANY OTHER PECUNIARY OR OTHER LOSS WHATSOEVER) 

ARISING OUT OF OR IN ANY WAY RELATED TO THE USE OF OR INABILITY TO USE THE 

PRODUCT, THE PROVISION OF OR FAILURE TO PROVIDE SUPPORT SERVICES, OR 

OTHERWISE UNDER OR IN CONNECTION WITH ANY PROVISION OF THIS LICENSE, 

EVEN IN THE EVENT OF THE FAULT, TORT (INCLUDING NEGLIGENCE), STRICT LIABILITY, 

BREACH OF CONTRACT OR BREACH OF WARRANTY OF FOXIT, EVEN IF FOXIT HAS 

BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.  

11.1.  LIMITATION OF LIABILITY AND REMEDIES. Notwithstanding any damages that 

You might incur for any reason whatsoever (including, without limitation, all 

damages referenced above and all direct or general damages), the entire 

liability of Foxit, its resellers and their subsidiaries under any provision of this License 

and Your exclusive remedy for all of the foregoing shall be limited to the amount 

actually paid by You for the Product.  The foregoing limitations, exclusions and 

disclaimers shall apply to the maximum extent permitted by applicable law, even 

if any remedy fails its essential purpose. 

11.2.  NOTICE TO U.S. GOVERNMENT END USERS 

11.3.  For contracts with agencies of the Department of Defense, the 

Government’s rights in: (1) commercial computer software and commercial 

computer software documentation shall be governed, pursuant to 48 C.F.R. 

227.7201 through 227.7202-4, by Foxit’s standard commercial license(s) for the 

respective product(s); (2) software and software documentation other than 

commercial computer software and commercial computer software 

documentation shall be governed by 48 C.F.R. 252.227-7014; (3) technical data 

for commercial items other than software or software documentation shall be 

governed by 48 C.F.R. 252.227-7015(b); and (4) technical data for 

non-commercial items other than software or software documentation shall be 

governed by 48 C.F.R. 252.227-7013. 

11.4.  For contracts with U.S. Government agencies other than the Department of 
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Defense agencies, the Government’s rights in: (1) commercial computer software 

and commercial computer software documentation shall be governed, pursuant 

to 48 C.F.R. 2.101 and 12.212, by Foxit’s standard commercial license(s) for the 

respective product(s); (2) software and software documentation other than 

commercial computer software and commercial computer software 

documentation shall be governed by 48 C.F.R. 52.227-14, Alternative III; and (3) 

technical data other than software and software documentation shall be 

governed by 48 C.F.R. 52.227-14 including, where applicable Alternatives I or II. 

12.   GENERAL.  This Agreement will be governed by and construed in 

accordance with the laws of the State of California excluding that body of laws 

known as conflicts of law.  The United Nations Convention on Contracts for the 

International Sale of Goods will not apply.  Any legal action or proceeding arising 

under this Agreement will be brought exclusively in the federal or state courts 

located in San Jose, California and the parties hereby irrevocably consent to the 

personal jurisdiction and venue therein.  You may not assign this Agreement or 

any right or interest hereunder, by operation of law or otherwise, without Foxit’s 

express prior written consent.  Any attempt to assign this Agreement, without such 

consent, will be null and of no effect.  Subject to the foregoing, this Agreement 

will bind and inure to the benefit of each party's successors and permitted 

assigns.  Except as expressly set forth in this Agreement, the exercise by either 

party of any of its remedies under this Agreement will be without prejudice to its 

other remedies under this Agreement or otherwise.  If for any reason a court of 

competent jurisdiction finds any provision of this Agreement invalid or 

unenforceable, that provision of the Agreement will be enforced to the maximum 

extent permissible and the other provisions of this Agreement will remain in full 

force and effect.  All notices or approvals required or permitted under this 

Agreement will be in writing and delivered by confirmed facsimile transmission, by 

overnight delivery services, or by certified mail, and in each instance will be 

deemed given upon receipt.  All notices or approvals will be sent to the 

addresses set forth in the applicable ordering document or invoice or to such 

other address as may be specified by either party to the other in accordance with 

this section.  Neither party will be responsible for any failure or delay in its 

performance under this Agreement (except for any payment obligations) due to 

causes beyond its reasonable control, including, but not limited to, labor disputes, 

strikes, lockouts, shortages of or inability to obtain labor, energy or supplies, war, 

terrorism, riot, or acts of God. The failure by either party to enforce any provision of 

this Agreement will not constitute a waiver of future enforcement of that or any 
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other provision.  This Agreement, including Foxit’s support and maintenance 

services terms constitutes the entire and exclusive agreement between the parties 

concerning its subject matter and supersedes all prior written and oral 

understandings and agreements between the parties regarding its subject 

matter.  The terms and conditions contained in any customer purchase order or 

other ordering document that are inconsistent with or in addition to the terms and 

conditions of this Agreement are hereby rejected by Foxit and will be deemed null 

and of no effect. 

13.   COMPLIANCE WITH LICENSES. If You are a business, company or organization, 

You agree that upon request from Foxit or its authorized representative You will 

within thirty (30) days fully document and certify that use of any and all Foxit 

Products at the time of the request is in conformity with Your valid licenses from 

Foxit.   

14.   DISCONTINUING OR MODIFYING SERVICES. You acknowledge that Foxit has 

the right to discontinue the manufacture and development of any of the Product 

and the support for that Product, in its sole discretion at any time, including the 

distribution of older Product versions, provided that Foxit agrees not to discontinue 

the support for that Product during the current annual term of this Agreement, 

subject to the termination provisions herein. Notwithstanding the foregoing, if Foxit 

discontinues the manufacture and support for a particular Product, Support for 

any remaining Products covered by this Agreement shall not be adversely 

affected. Foxit reserves the right to alter the Support, in its sole discretion but in no 

event shall such alterations result in: (a) diminished support from the level of 

support set forth herein; (b) materially diminished obligations for Foxit; or (c) Your 

materially diminished rights.  

15.  Should You have any questions concerning this License, or if You desire to 

contact Foxit for any reason, please call (510) 438-9090. 

 

 

 



Foxit PDF IFilter 1.0 for MOSS 

 12 

Overview 

Welcome to Foxit PDF IFilter 1.0 -- a professional tool that helps you to index PDF 

files. 

Foxit PDF IFilter is an application designed to help users index a large amount of 

PDF documents and then quickly find text within these documents. The PDF 

documents can not only be files, but also email attachments or database records. 

Foxit PDF IFilter supports PDF 1.7 specification and can be used in many Microsoft 

search engines, such as Windows Indexing Service, MSN Desktop Search, Internet 

Information Server, SharePoint Portal Server, Windows SharePoint Services (WSS), 

Site Server, Exchange Server, SQL Server and all other products based on Microsoft 

Search technology. With Foxit PDF IFilter, all these search engines can find PDF files 

with ease. 

Why PDF IFilter? 

PDF IFilter is necessary for several reasons listed below: 

 Microsoft creates and maintains office file formats, such as .doc, .xls, .ppt, etc. 

However, many other file formats are created and maintained by other 

companies. For example, PDF was created by Adobe.  

 With the advantages of security, reliability and accessibility, PDF is now being 

used by more and more people all over the world. 

 PDF IFilter is a plug-in that allows Microsoft search engines to index PDF files so 

that they become searchable. Without an appropriate PDF IFilter, contents of 

a PDF file cannot be indexed. 

Why Foxit PDF IFilter? 

Foxit PDF IFilter is favored by a large number of government organizations and 

well-known companies because of the following reasons: 

 Foxit PDF IFilter helps to do a two-stage search – Index and Search, which 

makes finding information much easier. 

 Foxit PDF IFilter supports multi-threading and makes full use of multi-CPU/core 

in a server. 

 Foxit PDF IFilter supports native 64-bit code. 

 Smaller and faster than other PDF IFilters. 
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 Supports Chinese/Japanese/Korean PDF documents. 

How Foxit PDF IFilter works? 

Foxit PDF IFilter acts as a plug-in for full-text search engines. A search engine 

usually works in two steps: 

Step 1, the search engine goes through a designated place, e.g. a file folder or a 

database, and indexes all documents or newly modified documents, including 

PDF documents, in the background and creates internal data to store indexing 

result. 

Step 2, a user specifies some keywords he/she would like to search and the search 

engine answers the query immediately by looking up the indexing result and 

responds to the user with all the documents that contains the keywords. 

During Step 1, the search engine itself doesn't understand format of a PDF 

document. Therefore, it looks in windows registry for an appropriate PDF IFilter and 

finds the Foxit PDF IFilter. Foxit PDF IFilter understands PDF format. It filters out 

embedded formatting and extracts text from the document and return text back 

to the search engine. Further information about IFilter specification can be found 

on the Microsoft Web site. 

Key benefits 

Here’s a list of benefits that Foxit PDF IFilter brings to you: 

 Integrates with existing operating systems and tools within your company. 

 Provides an easy solution to search within PDF documents located on local 

computer, local network and intranet. 

 Greatly increases your ability to accurately locate information. 

 Much smaller and faster than IFilter offered by other vendors. 

 Supports Chinese/Japanese/Korean PDF documents. 

 Supports native 64-bit code. 

 Supports multi-threading and takes full use of multiple-CPU in a server. 

http://msdn2.microsoft.com/en-us/library/ms691105.aspx
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Getting Started 

This section provides everything you’ll need to know about getting started with 

Foxit PDF IFilter, including its system requirement, installation and uninstallation. 

System requirements 

Foxit PDF IFilter 1.0 requires the following environment: 

 Microsoft Windows 2003 Server 

In addition, the environment must also contain Microsoft Office SharePoint Server. 

Installing Foxit PDF IFilter 

Foxit PDF IFilter has two versions respectively for 32-bit Windows and 64-bit 

Windows. You can choose one of them to install into your machine according to 

your system requirements. Before installing Foxit PDF IFilter, please note that 

Microsoft Office SharePoint Server has been installed successfully.  

To install Foxit PDF IFilter 1.0, please do the following: 

 Download Foxit PDF IFilter from Foxit Website (http://www.foxitsoftware.com) 

onto the machine where you wish to install it. 

 Stop the IIS Admin service: Start > Settings > Control Panel > Administrator 

Tools > Services > IIS Admin Service > Stop. Close window. 

 Run the Foxit PDF IFilter 1.0 Setup program to install the filter on the server. 

 Download PDF icon from http://www.foxitsoftware.com/pdf/ifilter/pdficon.gif. 

 Copy the downloaded .GIF file to "Drive:\Program Files\Common 

Files\Microsoft Shared\Web Server Extensions\12\Template\Images". 

 Edit the file “Drive:\Program Files\Common Files\Microsoft Shared\Web 

server extensions\12\Template\Xml\DOCICON.XML”: 

1. Right-click DOCICON.XML file > click Open With > select Notepad. 

2. Add an entry for the .pdf extension. For example, where ICPDF is the name 

of the .gif file:  

<Mapping Key="pdf" Value="icpdf.gif"/> 

http://www.foxitsoftware.com/
http://www.foxitsoftware.com/pdf/ifilter/pdficon.gif
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3. On the File menu, click Save, and then quit Notepad.  

 Perform an iisreset: 

1. Click Start > Run > type “cmd” in the Open line> click OK > type “iisreset” at 

the command prompt > hit Enter. 

 

2. Close the window. 

 Stop and start the Sharepoint Search Service by running the following 

commands: 

1. net stop osearch 

2. net start osearch 

3. net stop spsearch 

4. net start spsearch 

Notes:  

1. Foxit PDF IFilter appears in the list of programs on the Programs Start Menu after 

installation. 
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2. Foxit PDF IFilter has no user interface. 

3. The installation package will unzip a language file called fpdfcjk.bin into the 

installation folder, which will help you to index PDF documents containing 

Chinese/Japanese/Korean characters. 

Updating Foxit PDF IFilter 

When updating Foxit PDF IFilter, you need to uninstall the old version of Foxit PDF 

IFilter to install the new one. You do not have to reboot your machine after 

update. 

Generally speaking, Foxit PDF IFilter consists of a core layer and an installation 

layer. When you upgrade the installation layer, you do not need to re-do a full 

crawl. But when you upgrade the core layer, you can decide if you need to 

rebuild index on your computer according to the importance of the updates by 

checking what’s new details on Foxit Official Website. 

Uninstalling Foxit PDF IFilter 

To uninstall Foxit PDF IFilter, please perform the following: 

 Open the Start Menu > Settings > select “Control Panel”. 

 Click on the “Add or Remove Programs” tab. 

 Click on the “Foxit PDF IFilter” record and then on the “Remove” button to 

uninstall it. 

Or you can double-click the Foxit PDF IFilter.msi setup file that you have used to 

install Foxit PDF IFilter, and do the following: 

 In the Foxit PDF IFilter dialog box, select Remove Foxit PDF IFilter. 

 

 Click Finish button to uninstall it completely. 
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Working with Foxit PDF IFilter 

Foxit PDF IFilter is able to search text in PDF files. After you install Foxit PDF IFilter, you 

should upload your PDF documents and perform a full crawl with Microsoft Office 

SharePoint Server (MOSS) before you start a searching. 

You don’t have to do full crawls every time you add some new PDF files. You may 

schedule the incremental crawls for all the new ones. 

Indexing PDFs 

To index PDF files on your computer, please do the following: 

 Add the .pdf file type to the index list: 

1. Go to the Shared Service Administration: SharedServices 1 home page, 

click Search Settings link> under Crawl Settings click File Types. 

2. Click New File Type > type “pdf” in the File extension field > click OK. 

    

 

The PDF file type has been added 
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 Upload a PDF file, and perform a Full Crawl on the Search content indexes: 

1. Go to the Document Center, and click Documents. 

2. Click Upload, and then Upload Document. 

 

3. Click the Browse button to upload a PDF document and click OK. When it 

has uploaded, the Documents Edit Item page is displayed. You can give a 

title, if you like, to your uploaded PDF file. Click the Check In button. 

 

4. When you are done, you will be returned to the Documents page where 

you will see that your PDF file has been uploaded. 

5. Return to the Shared Service Administration: SharedServices 1 home page, 

click Search Settings link> under Crawl Settings click Content sources and 

crawl schedules. 
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6. On the Manage Content Sources page, open the content source’s context 

menu by left-clicking the down arrow and select Start Full Crawl to index all 

files. This will start the indexing process. 

 

7. (Optional) To start an incremental crawl, please open the content source’s 

context menu by left-clicking the down arrow and select Start Incremental 

Crawl. 

 View Crawl Logs. 

1. Return to the Document Center, and click Documents. 

2. Right-click the PDF document you have uploaded > choose Properties. 

3. Select the address (URL) of the PDF file except [filename.pdf] > right-click 

the selected area > choose Copy. 
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4. Go to the Manage Content Sources page, open the content source’s 

context menu by left-clicking the down arrow and select View Crawl Log > 

paste the URL to Find URLs that begin with the following hostname/path 

field > click the Filter button. 

 

5. When you’re done, you can see the whole URL of the uploaded PDF file 

appear in the Crawl Log list. 
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Searching PDFs 

After you finish indexing PDF files, you can start a search to find text within PDF files. 

Also, you can search PDF document properties, such as author, title, etc.  

To start a search, please perform the following: 

 Go to the Document Center, and click Search to visit the Search Center > 

type the text you want to search > hit Enter. 

 

 You will see your search results. Click to open one of the PDF files. 

 

Search results 
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Open one of the search results 

More Help 

For more information on how to work with Microsoft Office SharePoint Server 

(MOSS), please refer to Microsoft Office SharePoint Server (MOSS) Help included in 

the product. 
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Additional Information 

Microsoft Developer Support 

Foxit PDF IFilter is a Dynamic Link Library (DLL) file that provides a bridge between a 

Microsoft indexing client and a library of PDF files. It consists of code that 

understands the PDF Format as well as code that can interface with the indexing 

client. When an indexing client needs to index content from PDF files, it will look in 

its registry for an appropriate DLL and will find the Foxit PDF IFilter. Foxit PDF IFilter 

will return text to the indexing client. The indexing client will  then index the results 

and return the appropriate results to the user. 

Language Support 

This section lists languages supported by Foxit PDF IFilter 1.0. 

 German 

 French 

 Italian 

 English 

 Spanish 

 Portuguese 

 Russian 

 Chinese (traditional and simplified) 

 Korean 

 Japanese 

 Arab 

 Hebrew 
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FAQ 

1. What is Foxit PDF IFilter?  

Foxit PDF IFilter is an application designed to help users index a large amount of 

PDF documents and then quickly find text within these documents. It acts as a 

plug-in for full-text search engines that scans documents for text and properties 

(also called attributes), extracts text from documents, filters out formatting and 

retaining information about text position, and extracts properties of an entire 

document. 

2. Is Foxit PDF IFilter free?  

Foxit PDF IFilter can be used for free on desktop environment. However, users need 

to purchase licenses when they use Foxit PDF IFilter on server environments. 

3. I have a computer with one hyper-threading processor inside. Do I need to buy 

a license for 2 CPUs for the machine? 

We will only count the “real” numbers of processors reported by your system. 

Please go to Start > Programs > Accessories > System Tools > System Information to 

check your CPU numbers. 

4. What is the Foxit PDF IFilter's role in the PDF indexing process and PDF text search?  

Foxit PDF IFilter acts as a plug-in for full-text search engines. A search engine 

usually works in two steps: 

Step 1, the search engine goes through a designated place, e.g. a file folder or a 

database, and indexes all documents or newly modified documents, including 

PDF documents, in the background and creates internal data to store the 

indexing result. 

Step 2, a user specifies some keywords he would like to search and the search 

engine answers the query immediately by looking up the indexing result and 

responds to the user with all the documents that contain the keywords. 

During Step 1, the search engine itself doesn't understand the format of a PDF 

document. Therefore, it looks in the windows registry for an appropriate PDF IFilter 

and finds the Foxit PDF IFilter. Foxit PDF IFilter understands the PDF format. It filters 

out embedded formatting and extracts text from the document and returns text 

back to the search engine. Further information about IFilter specification can be 

found on the Microsoft Web site. 

5. Do I have to remove Adobe PDF IFilter to install Foxit PDF IFilter? 

Yes. 



Foxit PDF IFilter 1.0 for MOSS 

 25 

6. Where do I need to install the Foxit PDF IFilter in MOSS 2007?  

In MOSS 2007, the Foxit PDF IFilter only needs to be installed on the index server. 

7. How to verify the correct installation of Foxit PDF IFilter? 

Firstly, please check if Foxit PDF IFilter appears in the list of programs on the 

Program Start Menu after installation. 

Secondly, you can download IFilter detection tools to inspect IFilter installation 

information in the registry, e.g. the filtreg.exe program. 

Thirdly, install Windows Desktop Search to verify if the text in PDF files can be 

found. 

8. How to upgrade Foxit PDF IFilter? Do I need to reboot the machine?  

You need to uninstall the old version of Foxit PDF IFilter to install the new one. You 

do not have to reboot your machine after update. 

9. Do I have to rebuild index after updating?  

That depends. Foxit PDF IFilter consists of a core layer and an installation layer. 

When you upgrade the installation layer, you do not need to re-do a full index. But 

when you upgrade the core layer, you may need to rebuild index on your 

computer. 

10. Why can't I find some PDF files?  

There might be three reasons: 

First, Foxit PDF IFilter cannot index password-protected PDF files. 

Second, the PDF file doesn't contain searchable text. You can check if there is 

searchable text in the PDF file by opening it in Foxit Reader and selecting the text 

with the Select Text tool. Or you can enter into the Text Viewer mode to select text. 

If neither method highlights any text, it is likely that the PDF contains a source 

image of text which Foxit PDF IFilter can not index. 

Third, the PDF file doesn't contain text that is properly encoded. If the file contains 

searchable text, yet you cannot find the text with Find Tool in Foxit Reader, then 

the text may not be properly encoded. 

11. Why can't Foxit PDF IFilter work after Microsoft updates? Do I have to re-install it?  

If you installed the Foxit PDF IFilter on your search server, the IFilter does not work 

after you install a Microsoft update. It is because that the upgrade program 

automatically overwrites the registry value of Foxit PDF IFilter with that of Adobe 

PDF IFilter.  

To make it work again, you must reinstall Foxit PDF IFilter. In this case, you do not 

have to uninstall IFilter. You can just run the Foxit IFilter MSI program again and 
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select the repair function. In addition, we will contact Microsoft to address this 

issue shortly. 
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Contact Us 

Feel free to contact us should you need any information or have any problems 

with our products. We are always here, ready to serve you better. 

 

 Office Address: 

Foxit Corporation 

39819 Paseo Padre Parkway 

Fremont CA 94538 

USA 

 Mailing Address: 

Foxit Corporation 

39819 Paseo Padre Parkway 

Fremont CA 94538 

USA 

 Sales: 

1-866-MYFOXIT or 1-866-693-6948 (8AM-5PM PST Monday - Friday)  

510-438-9090 (8AM-5PM PST Monday - Friday) 

408-307-9358 (8AM-5PM PST Monday - Friday) 

 Support: 

1-866-MYFOXIT or 1-866-693-6948 (8AM-5PM PST Monday - Friday) 

979-446-0280 (6AM-5PM PST Monday - Friday) 

 Fax: 

510-405-9288 

 Website: 

www.foxitsoftware.com 

 E-mail: 

Sales and Information - sales@foxitsoftware.com 

Technical Support - support@foxitsoftware.com 

Marketing Service - marketing@foxitsoftware.com 

http://www.foxitsoftware.com/
mailto:sales@foxitsoftware.com
mailto:support@foxitsoftware.com
mailto:webmaster@foxitsoftware.com
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